Treasure Coast

acintsh
®

Users Group

1819 SW Willowbend Lane •
Palm City FL 34990 • (772) 283-5646

MEETING
Thursday June 20

Join us at our NEW PERMANENT
LOCATION - Children’s Services
Council • 101 SE Central Parkway, Stuart
• In the Green building between Bridges
Montessori and Unity Church. Click on this
map link http://tinyurl.com/clq2mkk
EXTENDED HELP SESSION TONIGHT
5 - 6:45 P.M. “Here To Help”
Bring your laptop, iPad or iPhone and enjoy
a format with Beginners tables throughout the
room, where you can just join any group:
• iPad
• Basic Help
• iPhoto
• Email
• Internet
• How can I ...
7:00 P.M. “Remember Widgets?”
Carol Vertesch shows us that Widgets are
handy and functional small programs on the
Mac that live in your Dashboard. Carol shows
how you can use Widgets to save time for
checking the weather, your favorite stocks,
doing calculations and other useful things.
7:25 P.M. “PhotoStream”
Bob Jorritsma explains this handy feature
to view and distribute your photos among
all your Apple devices. He will explain the
virtues of Photo Stream as well as possible
pitfalls.

Mouse Tales
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• Early Front Page Edition •
http://www.tcmug.net
MISSION: Since 1988, TCMUG has provided
a forum for Apple users by creating a member
network to share information and offer support
in the evolving world of technology.

iTunes 11 added a new “Home Videos” category
to help you separate out home movies from films and
other video content purchased from iTunes Store.
This is handy if you want to organize home videos in
iTunes to sync to devices and stream to Apple TV.
To use this new category on a video:
• Select it in iTunes
• hit Command-I (File > Get Info)
• click the Options tab
• change “Media Kind” to “Home Video”
• click OK to save your changes.
~ Thanks to Rick Stawarz, Finer Things in Tech

IN THIS ISSUE -

• iTunes 11 “Home Videos” category
• How to sign digital documents
• Bob Jorritsma: Dolly Drive
• iOS: Understanding Restrictions
(Parental Controls)
• Food & Nutrition Apps
• Find practically any file in OS X
• PopClip - Download of the Month

How to sign digital
documents
Q: I’ve received some electronic

documents that I’m supposed to
sign. I could print and sign them
and mail them back, but I’ve heard
there’s a way to sign them right on
my Mac. Do you know how it’s
done?

A: You have a couple of options.
If you’re running Mac OS X Lion
or later, you can take advantage
of Preview’s Signature feature.
Alternatively, you can use Adobe
Reader. We'll start with Preview.
Preview
Launch Preview, open its preferences, and select the Signatures
tab. Click the plus (+) button at the
bottom of the window.
A Signature Capture window
will appear and your Mac’s camera
will light up. Scrawl out your John
Hancock on a piece of paper, and
place that paper before the camera
so that the signature aligns with
the blue line in the viewer area.
Signature Capture will grab your
signature and display it to the right
of the viewer. Click the Accept
button, and the signature will be
added to Preview’s list of available
signatures.(See graphic below)

Capture your
signature with your
Mac's camera.
When you need to
sign a PDF, choose
Tools > Annotate >
Signature. A crosshairs cursor will
appear. Drag it, and
your signature will
appear. (If you’ve
stored more than
one signature, click
the Signature menu
in the toolbar and
select the signature
you wish to use.)
Drag the signature where you’d
like it to appear, and if necessary,
resize it. Save the PDF, and your
signature will be embedded in the
document.
Adobe Reader
You can also slap a signature
on PDF files with Adobe Reader .
While Reader doesn’t offer Preview’s camera trick, applying a
signature is pretty easy.
Open a PDF and click the Sign
button that appears in the toolbar.
Click the triangle next to the 'I
Need to Sign' heading and choose
Place Signature. In the Place
Signature window that appears,
choose Type my signature and
enter your name in the appro-

priate field. Your signature will
appear below in a script-like font.
Click the Accept button, place
your cursor where you’d like your
signature to appear, and click. The
signature will appear on the page,
where you can then resize it. (See
graphic above)
My signature was never so neat.
If the recipient of your document
is likely to respond with “I’ve
seen your signature, and that ain’t
it!” return to the Place Signature
command and choose Clear Saved
Signature. Now click Place Signature yet again and, in the window
that appears, choose Draw My
Signature from the first pop-up
menu and then do your darndest to
create a legible signature, scrawling it with your mouse or trackpad.
Again, click Accept when you’re
done and place the signature in the
document.
This kind of signature is fine in
some cases, but not all. For greater
security, some documents (those
with Adobe’s Reader Usage Rights
enabled) must be digitally signed.
Adobe Reader includes a feature
for creating such digital IDs. >>>
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TCMUG
Tech Tips

How to sign digital documents...
Launch Adobe Reader, open its
preferences, and select Signatures.
In the Identities & Trusted Certificates area, click the More button.
In the window that appears, you’ll
see a handful of certificates.
Click the Add ID button, and in
the resulting window enable the A
New Digital ID I Want To Create
Now option and click the Next button. In the Add Digital ID window,
enter your name and an email address. The Key Algorithm pop-up
menu offers two options—'1024bit RSA' and '2048-bit RSA'. The
latter is more secure but the former
is more widely compatible. Choose
one and click Next.
In the subsequent window, you’ll
see the location of your signature
file. Make a note of it should you
wish to back it up. Then enter and
confirm a password. When you’re
done, click the Finish button. Your
signature will appear at the bottom
of the certificate list. Click the
Close button and close the preferences window.
When you next need to sign a
document that requires a certificate just double-click in the digital
signature field, and the Sign Document dialog box will appear. Enter
the password for your signature
and follow the instructions to insert
your signature.
~ Christopher Breen, MacWorld

with Bob Jorritsma
bob@tcmug.net
Apple Certified
Tech. Coordinator
￼

Dolly Drive

There are so many
backup programs and services to build a
good reliable backup strategy. My feeling is however that there is way too much
redundancy between them. While I can use
the best features of several services to end
up supplying all I need, I would prefer less
of them. DollyDrive seems to be that one
service which has all the parts I need!
DollyDrive has very simple settings and a
nice menu with rapid shortcuts to the 4 features
of the program. The pricing is easy, starting at
$10.00 per month for 250GB and
depends on your Cloud space and
Dolly Space, while the Dolly Clone
and Local Backup are not measured.
Another unique feature is that
iTunes & iPhoto libraries can be
stored in the Cloud. Store your
entire iTunes and iPhoto libraries
in the Cloud with Dolly Space. Not
only will they be accessible from anywhere, but
it’s a great way to sync both locally across all of
your Macs. Maybe we can do a program about
DollyDrive if enough of you are interested.
		

~ Bob
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Be sure to click
on Dolly!

iOS: Understanding
Restrictions
(Parental Controls)

Symptoms can include:
• App missing from the
Home screen (Safari, Camera, or YouTube for example)
• Feature or service
unavailable (Siri, Location
Services, and so on)
• Setting missing or
grayed out (such as Mail,
Contacts, and Calendar;
iCloud; Twitter; FaceTime)

Products Affected:
iPad, iPhone, iPod
touch
You can enable and
adjust Restrictions, or
Parental Controls, on your
device to prevent access to
specific features or content
on the device. Locate these settings
by tapping Settings > General >
Restrictions.
Using Restrictions
To Enable Restrictions, tap
Enable Restrictions and enter a
passcode. The passcode will be
required to make changes to these
settings or to disable restrictions.
You can choose to restrict
access to the following applications and features on the device:
Safari
Camera (also disables FaceTime)
FaceTime
iTunes
iBookstore3
Installing apps
Deleting apps
Siri
Explicit language for Siri
You can choose to prevent
access to specific content types:
Ratings (select the country in the
ratings section to automatically apply the appropriate content ratings
for that region)
Music and podcasts
Movies
TV shows
Books
Apps

In-app purchases
You can also adjust the time
necessary before a password is
required to purchase content.
You can choose to prevent
changes to Privacy settings,
including:
Location Services
Contacts
Calendars
Reminders
Photos
Bluetooth sharing
Twitter
Facebook
You can choose to prevent
changes to the following settings/
accounts:
Accounts (disables changes to
Mail, Contacts, Calendars, iCloud,
and Twitter accounts)
Find My Friends4
Volume limit
You can choose to restrict features within Game Center:
Multiplayer games
Adding friends

Important: Restrictions
can also be enabled or enforced
using a profile (typically installed
when using the device for business or education purposes). You
can check for installed profiles in
Settings > General > Profiles. For
additional information, contact the
administrator or the person who
installed the profile.
Notes:
1. If you lose or forget a restriction passcode, you will need to
perform a factory restore to remove it.
http://support.apple.com/kb/
HT1414
2. YouTube can be restricted in
iOS 5 and earlier.
3. Find more information on
iBooks and iBookstore restrictions.
http://support.apple.com/kb/
HT5492
4. This will be available only
when the Find My Friends app is
installed.
5. Find information on Using
Parental Control in iTunes.
http://support.apple.com/kb/
ht1904

Additional Information
If your iOS device is missing a
particular application or if a certain feature is not available, ensure
that Restrictions are not enabled.
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~ http://support.apple.com

There’s	
  an	
  App	
  for	
  That!	
  

	
  
Carol	
  Turner	
  PhD,	
  RD,	
  LD	
  
Food	
  &	
  Nutrition	
  Specialist	
  	
  	
  New	
  Mexico	
  State	
  University	
  
May	
  2013	
  NEAFCS	
  Webinar	
  
	
  
General	
  Nutrition	
  Apps	
  
Fooducate	
  
Barcode	
  reader	
  helps	
  you	
  compare	
  food	
  at	
  
fooducate.com	
  
grocery	
  store.	
  Created	
  by	
  RDs.	
  Available	
  for	
  
fooducate.com
Free	
  
diabetes	
  and	
  food	
  allergy.	
  	
  
Introductory	
  video	
  online.	
  
	
  
Ziplist	
  
Creates	
  shopping	
  lists	
  from	
  online	
  recipes	
  
ziplist.com	
  
and	
  barcodes.	
  Recipes	
  can	
  be	
  “clipped”	
  from	
  
ziplist.com
Free	
  
many	
  online	
  sources.	
  Introductory	
  video	
  
online.	
  
	
  
Weight	
  Loss	
  Apps	
  
LoseIt	
  
Consolidate	
  food	
  and	
  workout	
  journal.	
  
loseit.com
loseit.com	
  
Reminds	
  you	
  when	
  you	
  forget	
  to	
  enter	
  log.	
  
Free	
  
Extensive	
  database	
  of	
  common	
  American	
  
foods.	
  
	
  
Calorie	
  Counter	
   Database	
  of	
  food	
  and	
  restaurant	
  guides.	
  Easy	
  
mynetdiary.com
mynetdiary.com	
  
entry,	
  track	
  water,	
  daily	
  reminder,	
  can	
  be	
  
$2.99	
  
trained	
  for	
  voice	
  entry.	
  Online	
  support	
  by	
  
RD.	
  
	
  
Food	
  &	
  Fitness	
  
More	
  than	
  1	
  million	
  foods	
  in	
  database.	
  
Tracker	
  for	
  
Customizable	
  meal	
  plans.	
  Exercise	
  examples.	
  
Sparkpeople	
  
High	
  quality	
  community	
  support.	
  
sparkpeople.com
sparkpeople.com	
  
	
  
$2.99	
  
Disease	
  Management	
  Apps	
  
Glucose	
  Buddy	
  
Convenient	
  way	
  to	
  log	
  and	
  track	
  BG	
  
glucosebuddy.com
glucosebuddy.com	
   readings.	
  Can	
  make	
  notes	
  about	
  outliers	
  and	
  
Free/$6.99	
  
email	
  them	
  to	
  health	
  care	
  provider	
  ($6.99).	
  
Social	
  Media	
  support.	
  
	
  
The	
  Gluten	
  
Assist	
  in	
  label	
  reading	
  and	
  identifying	
  
products	
  that	
  contain	
  gluten.	
  Section	
  of	
  food	
  
Detective	
  
label	
  FAQ.	
  Creates	
  shopping	
  lists.	
  
$1.99	
  
	
  
	
  
ScanAvert	
  
Register	
  health	
  profile	
  of	
  the	
  individual	
  and	
  
scanavert.com	
  
condition.	
  Barcodes	
  provide	
  immediate	
  
scanavert.com
$1.99	
  per	
  month	
  
feedback	
  and	
  suggest	
  substitutes.	
  Alert	
  sent	
  
	
  
if	
  scanned	
  item	
  has	
  been	
  recalled.	
  	
  
	
  
Other	
  
	
  
Quixey	
  
Search	
  engine	
  designed	
  specifically	
  for	
  apps	
  
quixey.com
quixey.com	
  
Download	
  for	
  iPhone,	
  iPad,	
  etc	
  
Go	
  to	
  itune	
  store	
  and	
  search	
  app	
  name	
  
Download	
  for	
  Android	
  
Go	
  to	
  Google	
  Play	
  and	
  search	
  app	
  name	
  
Download	
  for	
  Windows	
  Phone	
  
Go	
  to	
  windowsphoe.com	
  and	
  search	
  app	
  
name	
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Find practically any
file in OS X

Spotlight's default search
is limited to user files, but
if needed you can expand it
to include most system files.
by Topher Kessler
￼
The Spotlight feature in OS X is
a convenient tool for locating your
files, contacts, e-mails, and other
information by searching through
an index of file content and metadata in addition to file names.
While this feature's primary use is
for locating user data and resources
you may use, such as Applications
and system preferences, it can also
be used to find practically any file
on the system.
Spotlight's index of your hard
drive includes information on practically every file on the drive, but
since it is geared toward relevant
search results, by default Spotlight
does not include options to show
system files; however, Apple does
include a number of hidden filters
that you can use to enable these
results in your searches.
These filters are not available
through the Spotlight menu, but
if you invoke a standard Finder
search then you can add combinations of them to suit your needs
and find practically any file on the

system, be it a listing of a particular type, a specific detail
about one file, or even
hidden system files.
￼
By adding new filters (the
plus buttons) and setting
their search criteria (items in
the red rectangle), you can expand
and highly customize your search
results. (Credit: Screenshot by
Topher Kessler/CNET)
To do this, simply press Command-F in the Finder to bring up
a Finder search, and then click
the plus button to the right of the
search window to add a new filter.
Then select "other" in the first
drop-down menu to assign "System files" and "File visibility" for
the new filters, followed by adjusting them to include system files
and show hidden files.
Once completed, you can then
search for a keyword, such as a file
name. For example, if you want
to locate the "hosts" file in your
system to modify some network
access parameters, you can enter
it in the filtered finder search to
reveal it, even though it is hidden.
From the search results, you can
right-click a located document and
then choose the options to open
it or open its enclosing folder to
reveal it in the Finder. If
you perform this second option on a file that
is stored in a normally hidden directory
branch, then this hidden
folder will show in the
Finder where you can
access it and peruse its
location.
Using these advanced
search filters you can
also quickly list specific
file types in the system.

For example, you can locate any
audio file on the system, be it a
music file or a system- or application-specific sound, simply by
including the aforementioned filters and then changing the default
"Kind" filter to include only "Music" file types (note that you do not
need to include a search term to list
files in this manner).
With this approach, you can
locate files like "lockClosing.aif"
and "lockOpen.aif" buried deep in
the SecurityInterface framework,
which are the sounds you usually
hear when clicking the various
authentication locks on the system
to unlock system preferences and
other secured areas. Similarly, you
can change the "Kind" filter to
only include "Applications," and
thereby list any application on the
system and not just those in the /
Applications or /Applications/Utilities/ folders.
With these search filtering
options you can discover many
hidden features of the system by
targeting file types, instead of
manually exploring the filesystem
structure through the Finder. You
can also narrow results by starting
your search at a specific folder
(such as the System/Library folder
instead of your user account or the
entire system).
Do keep in mind that while these
searches can include many new
files and locations in the system,
they will only do so for files to
which your account has access.
Therefore, you cannot use them to
find files located in another user's
account. This is possible to do
with root-level access (e.g., if you
enable and log in as the root user,
or if you use Terminal equivalents
to these search options), but this is
not possible through normal Finder
and Spotlight searches. n
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PopClip - Download
of the Month
Submitted by Linas Venclauskas

This app from Pilotmoon,
gives you the iOS kind of
feel for the Mac.
PopClip appears when you select
text with your mouse in any app.
Instantly access context-specific
actions including cut, copy and
paste. If you select text containing
a URL, email address or file path,
PopClip can open it. Select a misspelled word, and PopClip offers
corrections. Select any text to do
a web search with those terms,
or select a single word to get the
dictionary definition.
￼ Plus, over 30 free extensions
are now available, including Paste
and Match Style, Translate, Send to
Evernote, Word Count, Capitalize
and much, much more. See http://
pilotmoon.com/popclip/extensions/
for a full list.

Reviews:
• “PopClip has achieved near perfect integration with Mac OS X and
seems like a default feature of the
operating system. For that alone,
it is worth its asking price.” – The
Next Web
• “An awesome new utility from
Pilotmoon that makes the copy &
paste function on your Mac look
just like the copy & paste function
on your iPhone” – Cult of Mac

• “If you love the tap and copy
functionality of iOS and want it on
your home computer, PopClip is a
simple app that adds similar functionality” – lifehacker
• “It’s pretty notable how intuitive and well-thought the app is.”
– Mac.AppStorm “I think even Mac
traditionalists might be tempted.” –
Dan Frakes, MacWorld
• “I’m buying it right now.” – Leo
Laporte, MacBreak Weekly

2013 MEMBERSHIP

Joining the Treasure Coast Macintosh Users Group will keep you from missing out on the best Mac
resource since the mouse — including the Monthly Meetings • Newsletter • Special Interest Groups
and more! Membership is just $30 a year per family - getting your colorful newsletter by e-mail.

q $30 Yearly Dues

Check payable to: TCMUG
(or Treasure Coast Macintosh Users Group)
Mail to:
1819 SW Willowbend Lane • Palm City FL 34990

Name _____________________________________________
Address _______________________________  Apt. _______
City ____________________ State _______ Zip _________
Phone _______________________  Fax ________________
Email address _______________________________________
Birthday (ex. Sep.24) His ________ Hers _______ Retired? ____  
__ Beginner __ Intermediate  __ Advanced __ Consultant
Computer model(s) _________________________________
Most used programs ________________________________
__ iPhoto __ Keynote   __ Pages  __ Numbers  __ iWeb  
__ Photoshop __ Quicken __ Skype
__ Filemaker   __ InDesign __ MS Office

Check what items you use:
__ Scanner
__ iPhone
__ Pages (layouts)
__ iPad
__ Keynote (slides)
__ iPod
__ Numbers (data)
__ iMovie
__ Laptop
__ iChat
__ 2+ computers
__ iDVD
__ iTunes
__ iWeb
__ Digital Camera
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2013
CALENDAR
President & Newsletter • Chris Kilbride    
    283-5646         chris@tcmug.net
Vice President & Publicity • Mark Weinberg
    465-4890             mark@tcmug.net
Treasurer • Dorothy Wharton
    220-9433  
dorothy@tcmug.net
Secretary • Kathy Finnerty
    220-8691  
kathy@tcmug.net
Beginners SIG • Carol Vertesch
   283-0843          carol@tcmug.net
Hospitality • Fred Ulbrich
    220-1303  
fred@tcmug.net
• Anita Farrell (after 12pm)
    370-7167            anita@tcmug.net
• Moe Goldy
    340-0652  
moe@tcmug.net
• Guy Reer      guy@tcmug.net
Membership • Jacques Hein
    
    288-2532          jacques@tcmug.net
Photos & Graphics •  Richard Lewis
287-4948     
  dick@tcmug.net
Technical Advisor (Apple) • Bob Jorritsma
    398-0748            bob@tcmug.net
Video Production • Bill Farrell (after 12pm)
   370-6407            bill@tcmug.net
   924-1084
(MagicJack)
Member At Large • Tom Stout
   288-3737
   tom@tcmug.net
Palm Beach Liaison • Dave Sochrin
  
   dave@tcmug.net

A variety of programs for Beginners
to Advanced Mac enthusiasts.

MEETING INFO
(772) 283-5646
http://www.tcmug.net
Dues may be paid in person
(cash or check), by mail or
credit card (tcmug.net)

MAILING ADDRESS
Treasure Coast Macintosh
Users Group (TCMUG)
1819 SW Willowbend Lane
Palm City FL 34990

Circus Ponies Notebook • Mark Weinberg
465-4890         mark@tcmug.net
Comcast
• Bill Farrell - after 12PM
370-6407   
  bill@tcmug.net
DropBox
• Bill Farrell - after 12PM
370-6407
   bill@tcmug.net
FileMaker
• Chris Kilbride
283-5646            chris@tcmug.net
iDVD
• Bob Jorritsma
    398-0748            bob@tcmug.net
iMovie		
• Bill Farrell - after 12PM
370-6407
   bill@tcmug.net
InDesign
• Chris Kilbride
283-5646            chris@tcmug.net
Internet
• Bob Jorritsma
    398-0748            bob@tcmug.net
MagicJack
• Bill Farrell - after 12PM
370-6407
   bill@tcmug.net
924-1084
   (MagicJack)
OS X
• Bob Jorritsma
    398-0748            bob@tcmug.net
Photos & Graphics •  Dick Lewis
287-4948        dick@tcmug.net
TurboTax
• Norm Argus (after 12PM)
561-968-0554    nargus@bellsouth.net
Websites
• Bob Jorritsma
    398-0748            bob@tcmug.net
		• Tom Stout
   288-3737
   tom@tcmug.net

Jan. 17 • Feb. 21
March 21 • April 18
May 16 • June 20
July 18 • NO Aug. 15
Sept. 19 • Oct. 17
Nov. 21 • Dec. 19

*All located at the Chilbren's
Services Council Auditorium
• MONTHLY VIDEOS •
http://www.youtube.com/user/
tcmug
BOARD OF DIRECTORS
August 30 @ Chris' office

MEETING LOCATION
Children's Services Council • Stuart
http://tinyurl.com/clq2mkk
101 SE Central Parkway, Stuart • (772) 283-5646 • In the
Green building between Bridges Montessori and Unity Church.
West Palm Beach Apple Store - Gardens Mall:
http://www.apple.com/retail/thegardensmall/
West Palm Beach Apple Store - Wellington Green:
http://www.apple.com/retail/wellingtongreen/
Find Out How:
http://www.apple.com/findouthow/mac/
iPad User Guide for iOS 5.1 Software • 143 pages
http://manuals.info.apple.com/en/ipad_user_guide.pdf
iPhone User Guide for iOS 6 Software • 155 pages
http://manuals.info.apple.com/en/iphone_user_guide.pdf

